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INTRODUCTION

"You're traveling through another dimension, a
dimension not only of sight and sound but of mind;
a journey into a wondrous land whose boundaries
are that of imagination. That's the signpost up
ahead - your next stop, the Twilight Zone!"

Rod Serling, 1959

For tradition-minded, precedent-driven attorneys, contemplation of high-tech
presentation of evidence might engender visions of unattainable technical plateaus
or nightmarish “Twilight Zone” scenes of horror and confusion.  It needn’t be so. 
Science fiction has become commonplace fact.

Why should a trial lawyer consider the “high-tech” presentation of evidence in his
or her case?  Because it reflects the world we live in and is the language of our age. 
Jurors exposed to radio and television expect (and demand) an engaging presentation
of the evidence.  The failure to do so risks aversion or ignorance to the message by
the trier of fact.  The fast pace of our world causes expectations and impatience when
those expectations are unmet.  Boredom sets in for even the most dedicated jurors
when the message is tedious and unengaging.  So, the answer to the rhetorical
question is that the price of a juror’s attention is that they be attracted to the message. 
To put it another way, they must be comfortable, if not entertained with the medium. 
This leads to receptivity to the message.

According to the Merriam-Webster Dictionary:

“Communicate” is to make known; 

“Persuade” is to move by argument, entreaty, or
expostulation to a belief, position, or course of action.

The trial lawyer seeks to both communicate and persuade.  Social scientists have
discovered that information is most readily accessed by an individual depending on
whether s/he is primarily auditory, visual or kinesthetic. 

Auditory individuals are primarily motivated or engaged by what they hear.

Visual individuals react most strongly to imagery presented to the eye.
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Kinesthetic individuals react most strongly to movement or emotion.

Therefore, in a group of individuals whose unconscious preferences may not be
known to them, much less the trial attorney, it is important to provide a mixture in
the presentation.  Hence, the significance of a “multi-media or “high-tech”
presentation.  

SCOPE

Other publications may be consulted about the distinctions between “real” evidence
and “documentary” evidence and “demonstrative” evidence. See, e.g. California
Trial Practice: Civil Procedure During Trial, Third Edition, Continuing Education
of the Bar, Randall Christison, Bryan A. Merryman, Dan Woods, March 2000
update, §§ 13.2-13.4, pp. 727-728.   

Commonly, “real” evidence is that which was created or became evidence during the
events giving rise to the dispute.  

“Documentary evidence” is  frequently included, but sometimes refers to real
evidence consisting of a writing.  California Evidence Code § 250 defines a writing
broadly to include “handwriting, typewriting, printing, photostating, photographing,
and every other means of recording upon any tangible thing any form of
communication or representation, including letters, words, pictures, sounds, or
symbols, or combinations thereof.”   

“Demonstrative evidence” refers to exhibits created or assembled as a result of the
lawsuit which is presented to aid the trier of fact in understanding witnesses’
testimony.  

This article will attempt to touch upon or explain some of the technology available
to present evidence of the various types.  Auditory, visual and kinesthetic appeal will
thus be enhanced in presenting the content and the message.

AUDIO

The simplest sound presentation is to bring an audiotape into court and play it. 
Equipment may consist of nothing more than a simple tape recorder with built-in
speaker.  Counsel have been known to bring entire stereos into the courtroom to
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maximize the impact of the recording.  The jury gets a real sense of the witness and
the drama of the interview.  This is more effective than merely describing the
incident or the interview on tape (as occurs in police incident related litigation.) 
However, presentation by audiotape has certain drawbacks.  If the attorney wants to
move forward or backward to a certain point on the tape, careful preparation must be
made so that precious time in front of the jury is not lost on trying to fast wind or
rewind to locate the desired segment. Preparation of a log keyed to the numeric
counter is essential for this type of presentation.  Nevertheless, a certain amount of
credibility may be lost if this is not done quickly.  If the audio to be played is more
than a minute, then an alternate method is recommended.

Transfer of the audio material to a compact disk or computer hard drive is relatively
easy and offers significant benefits.  Primarily, this is because of random access.  On
a compact disk (CD) the recording can be arranged in tracks, each of which can be
reached without playing or winding through the others.  When recording the CD, the
tracks can be cataloged by subject matter and number.  Later, the list can be viewed
to select the track just as one would do to make a musical selection, bypassing the
other material.  Alternatively, the entire recording can be played and replayed without
rewinding or delay.  

Conversion of audio to CD or computer involves copying the recording into digital
format.  The simplest way to do this is to take the source material on a tape recorder
and plug the output of the tape recorder into the input or microphone labeled input
of the sound card of a computer.   If the computer contains a CD drive which can1

Record from an external source within Windows ® Sound Recorder.1

1. Attach playback device (i.e. cassette recorder) to the Audio In jack on the rear of the sound card. The
computer end of that connection will require a 1/8” stereo audio jack.

2. Make sure the Line-In balance through Windows is not muted or set to a volume level less  than 50%. There
would be an icon in the system tray of windows that looks like a small yellow or blue loudspeaker. Double
click on this icon to display the volume controls for Windows.  If there is no vertical slider for Line In, find
the Options menu at the top of the window and choose Properties to display the list of volume controls
available. Make sure there is a check in the option for Line In.

3. Open Sound Recorder from Start, Programs, Accessories, and then Entertainment. (in Windows 98,
Windows ME and Windows 2000) or Multimedia (in Windows NT and Windows 95.)

4. Press the play button on the playback device.
5. Click the Record button in Sound Recorder.
6. Allow to source to play for duration of clip.
7. Click on the Stop button to end the recording.

This is a fast and easy way to record sound files from an external source. This will create a WAV file, but is limited
to sixty seconds in duration. You can record files that are longer than that, but it can be a headache.

Optionally, here are some basic controls for a shareware program that will allow longer recording times.
The software is called Gold Wave and can be found at the following website: http://www.goldwave.com/
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record compact disks, called CD-R or CD-RW (R for CD writeable, RW for CD
rewriteable) then the recording can be transferred onto a CD.  This is the preferable
format because otherwise the recording is limited to the computer hard drive and may
not be played without that computer, unless a transfer is effected. 

With inexpensive powerful software, audio source material, once converted into
digital format (i.e. computer readable) can be edited into tracks or culled into
whatever format is required for presentation. The author has had favorable
experience with Sound Forge® XP 4.5, from Sonic Foundry.  It is available on line2

or in retail outlets for between $40 and $55.  Also recommended are Goldwave®,
which is “shareware” obtainable online for free or a nominal fee.   Audio source3

material is not limited to audiotapes but can be obtained from videotapes or any other
material containing sound.  The process of copying, organizing and editing allows the
attorney or assistant not only to become reacquainted with the evidence, but requires
that some thought go into how the evidence will be presented as part of the process. 
By itself, this is a good thing.  

Subject to evidentiary foundation or other restrictions, audio files can be enhanced
for clarity or combined with music for presentation.  Persuasion, mastery and control
result when the attorney can quickly present the statement of a witness or other
relevant audio material.  Replaying a statement or a portion is no problem when the

Use the following steps for basic recording in Gold Wave:

1. Attach playback device (i.e. cassette recorder) to the Audio In jack on the rear of the sound card. The
computer end of that connection will require a 1/8” stereo audio jack.

2. Make sure the Line-In balance through Windows is not muted or set to a volume level less  than 50%. There
would be an icon in the system tray of windows that looks like a small yellow or blue loudspeaker. Double
click on this icon to display the volume controls for Windows.  If there is no vertical slider for Line In, find
the Options menu at the top of the window and choose Properties to display the list of volume controls
available. Make sure there is a check in the option for Line In.

3. Open Gold Wave and open the File menu and choose New…
4. On the new window that opens, click on CD and click the Next button. This window will allow you to

change the recording quality of the file to be created. CD quality is the best the option available in this
software.

5. A progress bar will extend across the screen as the software initializes the settings.
6. Click on the Tools menu, and then choose Device Options.  This will open a new screen will

recording/playback controls.
7. Click Play on your sound source and then click the Record button within Gold Wave.
8. Allow to source to play for duration of clip.
9. Click on the Stop button to end the recording.

http://www.sfoundry.com/2

http://www.goldwave.com/ 3
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audio material is digitized in CD track format or in separate computer files or folders. 
Opposing counsel and their clients will also be affected because of their concern that
impeachment by their own statement may be a mouse click away.  

If counsel prefers not to personally convert the audio into digital format, there are
businesses that will convert audio and video into digital format for a fee – usually a
substantial fee.  These “Service Bureaus” can be found by looking for imaging
services in the telephone book.  

VIDEO

If a picture is “worth 1,000 words”, according to the cliché, then the value of a
moving picture is mind boggling.  Humans and most other creatures are naturally
attracted to movement.  In the courtroom, this natural tendency can be put to good
use as long as the moving images are germane to the case.

Video is routinely captured on videotape which is familiar to most based on the VHS
format.  Similar, but higher resolution (more lines per screen) is the S-VHS format. 
Video images can be displayed simply by use of a video cassette recorder/playback
machine connected by cable to a television monitor or receiver.  Many courtrooms
now have such equipment available.  Inexpensive combination units are also
available for purchase.  Playback in this manner is simple, but suffers the same
disadvantages as the playback of an audiotape due to the disadvantages of the tape
format.  However, if the portion to be played is short or to be played continuously
without interruption, then this may be sufficient. 

If desired, shorter blank videotapes are available so that each item may be placed on
its own tape.  Search and rewind is simplified, but if there are too many tapes this can
become unwieldy.  

If you are planning to use courtroom supplied equipment, it is advisable to conduct
an inspection and a “dry run” to avoid problems.   This obviously also applies to the4

attorney’s own equipment, which should also be checked beforehand.

Transfer of the video images to a computer hard drive, especially for use in a trial
presentation system, discussed infra, will require that they be in digital format.

According to “Murphy’s Law”: “If anything can go wrong, it will.”  A corollary has been suggested:4

“Machines know when we most rely on them and will break down in direct proportion to the need we have for them
to perform.” 
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Conversion to digital format is unnecessary if the native format of the video is digital,
such as Mini DV.  High quality digital video cameras are available for around
$1,000.  Another benefit to the digital video format is that the resolution (picture
quality) is far greater than analog (non-digital) consumer-grade videos.  The savings
in not having to obtain conversion can easily be enough to pay for a consumer grade
digital video camera.  However, if conversion is necessary, then for a fee, a Service
Bureau will cause the necessary changes to occur and will generally provide the
finished product on a CD-ROM in digital format, usually MPEG-1 (a computer
digital video protocol.)

Editing of videos is beyond the scope of this article, but if the attorney seeks to
acquire the equipment and the knowledge, it is recommended that s/he begin in the
digital format with a digital video camera and a digital editor.  Digital video can be
downloaded onto a computer hard drive, edited there and then reloaded onto the same
or another digital videotape. Editing software is available on Sony® computers and
Apple© Macs, as well as individually available for PCs, packaged with installable
“firewire” cards which are frequently sold with editing software. There are also
portable digital video editors, but they are generally more expensive than digital
cameras and may lack the flexibility of editing on a computer.  Incidentally, the
newer digital tapes occupy very little space in the Mini DV® format.  One standard
size VHS cassette tape occupies roughly the same space as a dozen Mini DV digital
tapes.

What can be presented on video is limited only by the preparation of the attorney and
procedural and evidentiary rules.  Depositions of parties, witnesses, experts including
demonstrations, re-enactments which include tone and gesture missing from a “dry”
paper transcript.  The author is aware of a case involving an expert for the defense
in an insurance subrogation matter against an electrical manufacturer of circuit
breakers where defendant’s position was graphically undermined on video.  Plaintiff
claimed that the failure of a circuit breaker to operate was the cause of a short circuit
which led to a fire that burned down a factory.  During the defense expert’s video
deposition, he was asked to demonstrate the operation of the circuit breaker.   Finding
it blocked by a small Bakelite chip from the manufacturing process, he extracted a
pen knife and without a word, flicked it out of the device accompanied by an audible
click.  At trial this scene from the video was replayed for the jury which then awarded
a verdict in the multiple seven figure range.

In police liability cases it is useful to have parties and witnesses commit
unambiguously to their version of events.  It is also helpful to have experts do so,
especially when counsel believes that they may not fully grasp the facts necessary to
support their opinion.  In another matter involving this writer, a defense expert was
asked to demonstrate his understanding of the subject incident as related by the
primary defendant.  Using a three dimensional scale model, he demonstrated where
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he understood the defendant to be positioned at various times during the events
leading to the incident.  He was then asked whether being positioned elsewhere was
advisable or not.  He did not know the critical sequence of events which led to the
fatal shooting.  Defendant’s conduct was claimed to have caused the incident leading
to the use of deadly force.  At trial this portion of the video where the expert had
placed defendant was used to good effect.  His failure to understand the basic facts
showed that his opinion was not carefully derived.  Moreover, he opined that it would
be unreasonable for the defendant officer to take or maintain certain demonstrated
positions – unaware that defendant had placed himself there in his videotaped
deposition. This was obviously helpful in plaintiff’s case as it could be shown on
video that defendant’s own expert did not support his conduct as reasonable. 
Ambiguities in the written transcript may well have allowed the force of this
testimony to be dissipated, if not avoided altogether.  Use of the video hammered the
point home.

Presentation of video evidence requires careful planning, including noting the
beginning and end of proposed video clips to be played on direct examination. 
Evidentiary and court rules pertaining to objections to deposition and documentary
evidence must be followed in order to properly prepare video materials.  This
necessarily involves review of video materials in advance of court submission dates
for evidence lists in order to select and isolate the appropriate material – and
eliminate the inappropriate.  This can be time consuming and tedious, but is
necessary.  If video material is to be used for impeachment, it may not have to be
submitted to the court or revealed to the defense in advance, but may result in
significant time outside the presence of the jury for argument and rulings on
admissibility at trial.  Playing an admitted portion of a larger unedited video at trial
can be nerve wracking and distracting for counsel who must be poised to precisely
start and stop the video to show only what the court has allowed.  Importantly, if the
portion shown to the jury is not segregated, then the court probably will not allow it
as evidence into the jury room.  Although a certain amount of mid-trial editing is
inevitable, most counsel probably do not want the distraction of having to do so.  The
power and persuasion of a medium so familiar to the jury – and the court – makes the
extra effort worthwhile.

INDATA TRIAL DIRECTOR® PRESENTATION SYSTEM

The next step in organizing and presenting your high tech (and low tech) evidence
is to move it onto a computer which can access, manipulate and present it.  There are
several programs available for this function, but the author is most familiar with Trial
Director® software offered by InData Corporation, Gilbert Arizona.  Manufacturers,
such as InData will also build a computer, install and test the critical software.  Any
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data which can be placed into digital format can be then loaded into the program,
organized and prepared for presentation in a coherent fashion.  

A proper system allows the attorney to prepare and present his case, as well as to
adapt to the exigencies and necessities of trial.  Witness appropriate exhibits can be
grouped in folders on the hard drive, identified by witness, subject or otherwise. 
Exhibits in digital form can be copied to another folder with a mouse click.  

An exhibit can be created with overlays which allow the original exhibit to be shown
with markups, which can be sequentially developed.  Text and graphics are easily
added.  For example, an area can be pinpointed by a point, arrow, pointing finger,
circled, drawn by a square and indicated in many ways.  A very professional effect
is possible, not unlike static computer graphics seen on television news and weather
programs.

When an incident has developed where locations of various participants is in issue,
a photograph may be presented and the witness asked to locate a person or an object
at a given point in time.  As the jury and the court watches (unlike a tiny photo or
diagram) the location identified by the witness can be marked, a new exhibit number
identified, printed (on a color printer) and offered into evidence.  

While this could also be done with a two dimensional exhibit, that would require
preparation of numerous poster boards, which may or may not prove to be necessary
or helpful.  Furthermore, once an exhibit has been created, it can be shown with other
exhibits simultaneously so the jury can compare.  The composite can be identified
and placed into evidence to cement the comparison with the trier of fact.   Exhibits
can be juxtaposed with other exhibits in a composite of up to nine items.  Any item
can be enlarged as it is selected from the composite.     

Video clips can be played in full screen mode, with audio of course, and with
synchronized transcripts rolling along underneath the deponent.  The software allows
the video to be paused at any point along with the relevant testimony shown on the
transcript.  

When an important point needs emphasis, it can be highlighted with presentation of
a relevant exhibit next to the speaker.  For example, if a deponent is referring to a
subject in a writing, diagram or exhibit in the testimony, that item can be juxtaposed
next to the speaker in closeup.  A dramatic example of this occurred in the recent
U.S. Justice Department antitrust trial against Microsoft Corporation.  Corporate
president, Bill Gates was shown as a talking head (and shoulders) in his deposition. 
He denied that Microsoft had any plans to target Netscape, a rival web browser
competitor.  At or about the point when Gates is making his denial, an email culled
from discovery from Microsoft data appears next to him on the screen, saying
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(paraphrased) “Let’s go after Netscape.”  The trier of fact could compare the visual
denial and the associated body language with the powerful impeachment evidence
to the contrary.  5

Additionally, any visual item on the computer may be digitally enlarged in seconds,
including specific portions which can by “pulled out” for more emphasis. This
feature shows the original document and a portion identified by lines which then
extend to an enlarged version so that the source and content are unmistakable.

Both static and moving images can be saved into the computer in advance for high
tech presentation during trial.  Photographs, reports, drawings, learned treatises,
written policies, as well as audio alone or video alone or with audio can all be
included for use at trial – with or without markups and overlays. During trial, this
system along with a scanner and color printer can add items to the data base,
manipulate and print them out on the fly.  Sufficiently powerful laptops are now
produced so that the entire database and program can be carried to court in the
morning and easily taken away for review or preparation thereafter.

Trial Director® supports computer video cards with dual monitor output.   With two
outputs (monitor + monitor or monitor + projector) the attorney or assistant can pull
up the next exhibit for review without presenting it to opposing counsel, the court or
the trier of fact.  The attorney can review future exhibits to select which one s/he
desires to publish to use with the witness.  Additionally, extra monitors can be
attached to a video amplifier so that counsel and the court may have a view of an
exhibit before it is presented to the witness and the jury.

Up to 9 zone combinations are available, so that numerous exhibits may be presented
simultaneously or selected for enlargement to full screen, half or quarter.

Another feature of the system is that a bar code scanner may be used. An exhibit
book with thumbnail images can be printed from the system with bar codes.  At the
necessary or appropriate time, the handheld bar code scanner reads the bar code from
the exhibit book and, like magic, the exhibit appears on the screen.  Additionally,
“scripts” or automated commands can be programmed which cause a sequence of
events to occur, such as playing of a video deposition and displaying an exhibit at an
appropriate moment.

Bench officers are often pleased with the novelty and utility of a trial presentation
system, particularly so if they can be shown how it will streamline the trial
presentation of evidence.  It is evident from the use of such a system that the attorney
is serious and prepared in the presentation of his case.  This unspoken message is

The software used was Trial Director® by InData Corporation, http://www.indatacorp.com/. 5
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persuasive in itself.

LCD PROJECTOR

A Liquid Crystal Display (“LCD”) projector is a very useful multimedia device to
make a high tech presentation of evidence.  It can take the output of most analog (e.g.
tape player or VCR) or digital devices (computer, digital video camera or DAT
recorder) and present the visual material dramatically in a large format, along with
sound. These projectors can be rented, but if counsel contemplates an extended trial
it is better to buy because the rental rate can be quite high, extending to three or four
hundred dollars per day.

Unlike computer monitors or television monitors which are cumbersome and limit
the size for conveniently moving into the courtroom, the LCD projector and screen
can be easily transported and can yield an image four feet tall and more than five feet
wide, or more.  With a larger screen and powerful projector this can be exceeded,
though it is probably not necessary.  Very small projectors suitable for darkened
small conference rooms are generally unsuitable for extended use in a well-lit
courtroom.  Brightness is measure in ANSI lumens.  Generally, anything less than
1,000 lumens is going to be difficult to see in a brightly lit courtroom.  The brighter
units will allow greater resolution and detail to be seen, rather than “washed out” like
when someone opens the exterior door to a movie theater allowing the sunlight to
reach the screen.  The author has found a projector with 2200 ANSI lumens to be
very satisfactory.  

Demonstration should be had of any contemplated projector, especially noting the
highest resolution obtainable.  Resolution of at least 1024 x 768 should be sought,
as that is commonly used to display images from a computer output.

It is unusual for courtrooms to have an available projection screen, at least until more
modern courtrooms are built.  The attorney should therefore plan to obtain a
projection screen suitable for use with an LCD projector.  Older models with a silver
coating, used with overhead projectors, are generally disfavored.  Pure white screens
are most appropriate for LCD projectors.  DA-LITE® makes a line of portable
screens that are highly suitable for this purpose.  The company’s products may be
viewed at http://www.da-lite.com/ or a local retailer.

An attorney supplied platform is recommended for the projector because placement
on counsel table or adjacent courtroom surfaces may not be suitable.  DA-LITE®

makes a line of highly portable collapsible projector stands with telescoping legs
which are very handy for supporting the projector.  
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Though not strictly necessary, it is helpful to have a remote control device to operate
the projector, particularly if it is mounted in the “well” of the courtroom.  Otherwise,
counsel will be constantly traversing the counsel table to get to it.  Additionally,
some manufacturers build pointing devices into their remote.  This will allow counsel
to use the remote as a pointer and highlighter device.  Laser pointers are also
recommended to provide the witness or to be used by counsel as an alternate. 

Many projectors have multiple inputs, thus allowing video, computer, opaque
projectors (such as an ELMO®) to be simultaneously connected, allowing switching
between inputs.  

Although audio speakers are often provided within LCD projectors, it is a good idea
to have separate self-powered computer speakers available.  They will generally
project the sound better with a greater tonal quality and range.  If extremely critical
listening is necessary, other arrangements including stereo speakers and amplification
might be recommended.

A service contract with a 2 hour guarantee to minimize downtime is worthwhile,
whether you are renting or have purchased a projector.  A spare projector bulb,
though quite expensive is recommended.

3D MODELS

While the above presentation devices are extremely convenient, helpful and
persuasive, they are limited to a flat, two dimensional presentation.  Where spatial
relationships are important to show, then a three dimensional model may be needed. 
A police shooting scene frequently involves issues of relationships of persons and
places, distance, cover, concealment as part of the overall calculus of reasonableness. 

Models should be to scale in all important aspects.   However, their primary value6

Defense counsel are fond of nitpicking every aspect of these models, seeking some basis for exclusion.6

 Generally, however, if they are a fair representation of what is depicted, they may be used for demonstrative purposes,
if not admissible into evidence outright.  As stated in People v. Jackson, 74 Cal.App.2d 22,167 P.2d 776 (1946) 'The
rules of evidence in civil actions are applicable to criminal actions.., and, under proper restrictions of proof, models,
facsimiles, and photographs are admissible in criminal as well as in civil cases.'  This court,  following this well
established rule, held in the case of People v. Sambrano, 33 Cal.App.2d 200, at 213, 91 P.2d 221, 228, that the trial court
did not err in admitting photographs 'to show the nature of the surroundings where the homicide occurred.  Courts are
authorized to receive in evidence photographs in the same class as diagrams, when they accurately depict the locality
of the crime, together with weapons, objects and physical conditions which are unchanged in status or in relation  to other
surrounding conditions as shown at the trial by accompanying testimony.’ (Emphasis added, concluding citations
omitted) Id. at 74 Cal.App.2d 25.
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is in allowing a true visualization of an incident.  If used at deposition or trial, a
properly prepared model allows the viewer/juror to “get the feel” of the locale.  If
used in conjunction with a videotaped deposition, a witness or party can be recorded
relating the incident, step-by-step, by demonstrating and explaining.  A closeup taken
at the time can transport the viewer right into the scene.  

Frequently, lay witnesses and jurors may hear a description of a distance or a position
but do not really “get it” until they see and relate to the landmarks involved.  It is not
uncommon for people to give an inaccurate distance estimate because of
unfamiliarity with accurately doing so or prompting by police investigators. 
However, frequently the witness can state that s/he was in a certain place which s/he
can point to with certainty (captured on videotape at deposition.)  Police reports can
be impeached when impartial witnesses demonstrate what they remember from their
visual memory sense and can plausibly explain that their distance estimate was
untutored and inaccurate.

The decision to create a 3D model probably depends on whether the location of
persons and things is in issue or not.  If it is, then preparation of the model must
allow important points of reference to be represented as accurately as reasonably
possible.  For example, the author was involved in a police shooting in which the
location of a police car was very important as witnesses placed the shooter adjacent
to it.  Police photos depicted the car in the street, which was made of asphalt with
large distinctively shaped cracks.  The model maker and the author went to the scene
and carefully measured the cracks in the roadway to reference points nearby.  The
resulting model contained scale cracks in the roadway, allowing the placement of the
police car to mimic the photos taken at the scene.  At deposition, the witness testified
convincingly that the shooter was at the driver’s side door of the police car – which
was established to be approximately 45 feet away from the plaintiff, who was
rendered a paraplegic when shot, assertedly in “self-defense.”  The case settled
favorably without the necessity of ever deposing the involved officers.

As related above in an earlier section, an expert was presented with a 3D model of
the scene of the subject incident and asked to demonstrate his understanding of what
occurred – upon which his opinions were assertedly based.  The jury’s familiarity
with the scene from other evidence and the 3D model allowed them to quickly
understand the contentions made.

Use of 3D models in police shooting cases is especially helpful because of issues of
reasonableness and necessity.  Was there cover?  Was concealment available?  Was
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line of sight available?  Was retreat, aka redeployment in police jargon, a reasonable
alternative to the use of deadly force?   Was the decedent/victim close enough to be
a reasonable threat? What were the options in terms of the physical layout?  Some
people are better at visualization than others, but all seem to benefit from the
overview perspective that a 3D model provides.

Although 3D models are low-tech and often have a dollhouse feel to them, they are
not inexpensive and can easily cost thousands of dollars.  However, the persuasion
sought by “high-tech” presentation methods, which are still generally two
dimensional, can be obtained or augmented by a 3D model, where appropriate.

There is a sense of the macabre in 3D models because the sense of reality is
heightened.  In a suitable case, the message is also that this could have been avoided. 
 Or as Rod Serling would intone: “Lesson learned ...in the Twilight Zone.”
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